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[bookmark: _Toc127333203][bookmark: _Toc13907870]Overview
[bookmark: INSERT_HERE]1.1	Introduction
The purpose of this planning document is to outline the various aspects involved in the compilation of a Skype User Guide for Beginners. The technical level of this document is considered easy to moderate, with the intention of eventually being read by individuals who plan on becoming Skype users. Re-using the same information from this document plan in the resulting Skype User Guide will allow for a more efficient publishing process. The main audience of this documentation plan are Skype’s team of Technical Writers who must draw upon it to create the resulting User Guide. 
The Skype User Guide is marketed towards family members that live abroad and find it difficult to keep in contact with other family members that live in other countries, or other parts of the same country. Physical distance is a barrier that Skype can transcend to strengthen family and friendship bonds. The intention of this documentation plan is to begin to develop the components of the resulting Skype User Guide for beginners.
[bookmark: _Toc146698395][bookmark: _Toc9415722]
0. Scope
This document plan for the Skype User Guide for Beginners covers many components: document and product assumption and constraints, the contents (headings) contained in the Skype User Guide for Beginners, an explanation of the users, specific task descriptions for learning how to use Skype, the usability goals of this document, a look into existing documentation, an explanation of design implications, the specifications of this document, supporting platforms, whether graphics will be used or not, how the media will be delivered, localization needs, supplementary material required, terminology explained, a detailed process and schedule, a record of approvals, the review process, how changes to the document will be handled, production and distribution, resources used and an overview of risks and issues.  
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[bookmark: _Toc180823606][bookmark: _Toc214865842][bookmark: _Toc466743500][bookmark: _Toc494635429][bookmark: _Toc127333205]
Assumptions and Constraints
[bookmark: _Toc180823608][bookmark: _Toc214865844][bookmark: _Toc466743502][bookmark: _Toc494635431]It is assumed that the Skype User Guide for Beginners is tailored towards users who have moderate computer proficiency skills and own a laptop and/or desktop that runs on Microsoft Windows 10, with a strong, established internet connection-not an Apple product. Skype users would be using Skype on their laptop or desktop for the main functions of video calling, voice calling and file sharing. It is assumed that the users participate in a family set-up where members of the family are separated by physical distance. It is assumed that users can read, write and speak moderate to proficient English.

The Skype User Guide for Beginners is geared towards family members that live abroad and would like to keep in contact more frequently with their loved ones. The Skype User Guide for Beginners is not geared towards potential users who would like to use Skype on their phone, or for those who would like to use Skype credit to make phone calls to mobile or landline phones. Also, the Skype User Guide is not for users who want to run Skype on a laptop or desktop running on an older version of Microsoft Windows (not Microsoft Windows 10). Last, the Skype User Guide is not geared towards users who choose to own and use an Apple product (iPhone, Mac, etc.).

In addition, the Skype User Guide for Beginners will be compacted and presented in an information tutorial 30-second video and 3-minute video available on the Skype Online Help Website. The 30-second video will present a commercial script advertising how users can utilize the video calling, voice calling and file sharing applications on Skype with their Windows 10 Laptop or Desktop. The 3-minute video will go more in depth about how to utilize these Skype features, as well as setting-up voicemail, listening to voicemail and adding contacts. The constraints to the 30-second commercial video and the 3-minute tutorial video are mostly time-sensitivity, and ensuring the script for both videos covers the basic features of Skype that potential users would utilize the most. In-depth instructions of how to navigate through Skype and use its other features step-by-step are better explained in the Skype User Guide for Beginners in print format. Last, the User Guide and 2 videos are to be completed in a 30-day deadline-another time constraint.

1.4	The Project
The purpose of this documentation plan is to compile all the information that is meaningfully geared towards the creation of a Skype User Guide for Beginners. In addition, an accompanying 30-second video and a 3-minute video are to be produced. The 30-second video is a commercial featuring the video calling, voice calling and file sharing applications of Skype that runs on a Windows 10 Desktop or Laptop. The 3-minute video will feature these exact same Skype applications, but also highlight how to add contacts, create voicemail and listen to recorded messages left by others. Understanding the targeted audience and the way they choose to use Skype for their own purposes of keeping in touch with loved ones, will help produce information in the resulting User Guide and videos that is meaningful. The Skype User Guide for Beginners will be published in English, with an opportunity for translation (closed captioning) for the accompanying 30-second video and 3-minute video. The videos will be presented in English script as well, but feature closed captioning available in other languages (e.g. Punjabi, Italian, French, Spanish).
Target Audience
Users
[bookmark: _Toc180823611][bookmark: _Toc214865847][bookmark: _Toc466743505][bookmark: _Toc494635434][bookmark: _GoBack]The solution is being developed for family members to keep in-touch over Skype, as families may be spread-out and certain members may live abroad and find themselves isolated. Individuals come from upper-middle class families that have regular access to computers. Computer usage varies from the studying student who uses the computer to complete their homework, to the grandchild who uses the computer to keep-up with social media and play video games, to the senior who uses the internet to pay bills, to the parent who uses a computer to check their e-mail and read the news. Personas were developed to encompass individuals of varying ages and computer usage purposes. What the personas all have in common is a preference to use Skype on their Desktop or Laptops to video call, voice call and file share with their family members living abroad. With access to internet, few users described an interest in purchasing Skype Credit to make calls to landline and mobile numbers. Skype is marketed as a communications service that would allow these Personas/Target Audience members to communicate with their relatives more frequently and for a lower price than making international calls.

2.2	Methodology 
As a prerequisite to receiving the Skype training material, participants were asked to complete a brief survey form online. The survey consisted of a simple interface with text, icons, and buttons for proceeding in the survey. The questions on the survey assessed internet usage, ranking of goals and expectations of Skype, and preferences for modes of instruction. The entire online survey taking process was audited by a Skype representative who took note of the font size, icon size and screen contrast settings that participants felt most comfortable with. The auditor also recorded impressions about ease of reading and ability to follow directions in the survey.

2.3 	Personas

A.) Kaya Kiranthi is 18 years old, originally from Mumbai, India. She is currently studying in Canada as an international student and finds herself tight on funds. She is an only-child and very close to her parents, especially her mother. She cannot always go home to visit her parents and extended family due to financial constraints. Kaya is also a foodie and shares her mother’s passion for cooking. In addition, she has a pet lizard and cat back home in India that she misses very much. Kaya has discovered Skype and would like to use its video calling and file features to keep in contact with her parents, show-off her daily cooking to her mother and view pictures of how her pets are doing. According to a study conducted by CivicScience, 75% of millennials like Kaya, are addicted to their digital devices and utilize technology-like Skype’s video-chatting app-frequently (Tseggay).

Kaya’s User Needs Analysis:
· Kaya uses the internet on her laptop every day for school studies and assignments. 
· Kaya uses WhatsApp chat (group chat and file sharing) and Facebook messenger (mobile calling and file sharing) to contact her parents once every weekend.
· Kaya would like to use Skype’s video calling and file sharing features to connect with her parents.
· Kaya is technologically savvy and can read smaller font sizes and navigate through smaller icons on Skype’s main page.
· She is highly fluent in written and spoken English.
· Kaya should use online tutorial videos and a quick starter guide to learn how to use Skype.

B.) Rick Costanza is aged 42 and is a musician. Rick immigrated from Ecuador 15 years a go on a working Visa, and first re-located to Nashville, Tennessee in the United States. He has obtained his Green Card and currently lives in New York. Being recently divorced from his wife of 15 years, Rick is also separated from his step-kids who live with their mother. Rick misses his step-kids Annie (age 15) and Michael (age 17). Since Rick travels a lot for work as a musician, he rarely ever gets time to visit or call his step-kids and keep in touch. Currently, Rick uses his cell phone to make international calls to his step-kids once every two-weeks. 
Also, Rick is very close to his Ecuadorian friends who are also in their 40’s. They all grew-up together. When he has the downtime, he schedules flights back to Ecuador to visit his friends and now, connects with them mostly through WhatsApp group chat. As Rick is a spender and not a saver, he is heavily in debt and looking for ways to cut costs and eventually save more money than he is spending. Skype is appealing to him because the video calling feature enables him to connect with his step-kids and Ecuadorian friends and costs nothing, if everyone has an internet connection.

Rick’s User Needs Analysis:
· Rick uses the internet on his laptop to tweet, update his personal and band Facebook pages, and for leisure purposes.
· Rick finds the time to contribute towards the WhatsApp group chat that his Ecuadorian friends and he developed, at least 3-4 times a week.
· Rick calls his step-kids’ cell phones at least once every 2 weeks.
· Rick would like to use the video calling and voice-to-voice calling features of Skype to connect more often with his step-kids and Ecuadorian friends, without the extra costs.
· Rick would need high contrast colouring, larger font and icons when navigating the instructional materials of Skype.
· Rick is highly competent in written and spoken English.
· For Rick, who doe not have a lot of time, a tutorial video and quick start guide should suffice for learning how to use Skype.

[bookmark: _Hlk495917757]C.) Mario Luigi is 68 years old and is an artist who creates and sells Mosaics for a living. is a grandpa from Rome, Italy. He is an artist who creates mosaics for a living and has his own personal studio. Mario would like to expose his grandkids to his love of art and collage-making. Mario’s only son, the father of his grandkids, currently resides in France, a long with Mario’s daughter-in-law and grandchildren. Art is a cultural heritage that Mario would like to pass-on to his grandchildren. Mario would like to use Skype to video call his grandchildren on their home desktop, and file share some of the pictures he has uploaded regarding his mosaic works. According to the Pew Research Center, seniors aged 65 and older, like Mario Luigi, use Skype and other social media platforms to “bridge the geographic gap between them and loved ones far away and to reconnect with friends from a far-off time…the internet has become an important portal for reducing isolation, loneliness and other depressive symptoms” (Kamiel).
Mario’s User Needs Analysis:
· Mario already uses the internet on his computer to advertise his mosaic works and to manage online transactions whenever customers purchase his artwork.
· Mario is constantly updating his Mosaic works website.
· Mario calls his grandkids from home line to home line (Italy to France) once a week, and only speaks briefly to his son. He is more interested in speaking Italian to his grandkids and ensuring they do not forget their native language.
· Mario would like to use the video calling and file sharing features of Skype to better communicate with his grandkids and show them his latest artwork.
· Mario needs high contrast in colours, larger fonts and icons when navigating the help materials for Skype.
· Mario is moderately competent in written and spoken English, but would prefer an Italian translation of text.
· Mario has the time to read a manual and search for online help when learning how to use Skype, but the content should be presented in both English and Italian.


2.4	Task Description
	Task Name: Getting Started: How to Download Skype onto Windows 10 Desktop/Laptop Computer

	Step Number
	Resources Used
	Time  
	Problems 

	Step 1
	Open the internet browser on your Desktop or Laptop.
	Desktop/Laptop, Internet, Mouse, Keyboard


	10 seconds
	You may not have Windows 10 on your Desktop or Laptop.

You may be using an Apple product with a different configuration.

	Step 2
	On the Google webpage, type-in Skype into the Search Toolbar.
	Same
	5 seconds
	You may not be using Google as your web search source.

	Step 3
	Click on the first link of results or type in this URL:
http://www.skype.com/en/
	Same
	10 seconds
	The first link on the Google search results page may not be the main page URL for Skype.

	Step 4
	On Skype’s main webpage, click Download Skype.
	Same
	5 seconds
	If the icon button for Download Skype is too small, you may miss it.

	Step 5
	Choose Computer option to download Skype onto your Desktop/Laptop.
	Same
	5 seconds
	If you click the wrong button and choose the phone or tablet options instead, press the backwards arrow button on the top left corner of the webpage to navigate back to the last page.

	Step 6
	Click Launch Skype Now button.
	Same
	5 seconds
	ESL users may not understand the meaning of Launch Skype Now button.



	Task Name: Getting Started: Installing Skype and Creating a New Account

	Step Number
	Resources Used
	Time 
	Problems 

	Step 1
	Create a new account:

1.) Enter your Country, Phone Number and Password. OR:

2.) Enter your Country, E-mail and Password.
	Desktop/Laptop, Internet, Mouse, Keyboard, Skype
	5 minutes
	You type in the wrong country, phone number, e-mail or password. 

	Step 3
	Add details like your First Name and Last Name and click Next.
	Same
	1 minute
	You spell your First Name or Last Name incorrectly.


	Step 4
	Skype should send a 4-digit code to the corresponding phone number or e-mail you entered.
	Same
	5 minutes
	You do not receive the 4-digit code and need to ask for a new one.

	Step 5
	Enter the 4-digit code and press the Next button.
	Same
	10 seconds
	None.

	Step 6
	1.) On the main Skype window, upload an existing Profile Picture (optional) by pressing the Browse button and selecting the location of the file in your computer.

2.) Take a Profile Picture using the existing built-in webcam installed on your Desktop/Laptop. Use it as your Skype Profile Picture.
	Same
	5 minutes
	You do not own a built-in webcam to take a Profile Picture.

	Step 7
	Press the View tab on the top of the Skype window and click on Profile. 
	Same
	5 seconds
	None.

	Step 8
	Edit all contact information to your personal preferences by filling-in each category, and click the checkmark icon after to submit the information.
	Same
	5 minutes
	You cannot change the viewing preferences for each piece of information. 




	Task Name: Getting Started: Booting Skype

	Step Number
	Resources Used
	Time 
	Problems 

	Step 1
	Press the X icon at the top right corner of the Skype window to close the application.
	Desktop/Laptop, Mouse
	5 seconds
	None.

	Step 2
	Right-Click the Skype icon pinned to the taskbar on the bottom of your Desktop/Laptop’s main screen.
	Same
	5 seconds
	None.

	Step 3
	Click Sign Out. 
	Same
	5 seconds
	None.

	Step 4
	Again, right-click the Skype icon pinned to the taskbar on the bottom of your Desktop/Laptop’s main screen.
	Same
	5 seconds
	None.

	Step 5
	Click the X icon for Close Window.
	Same
	5 seconds
	None.

	Step 6
	Right-click on the Recycle Bin icon on your Desktop/Laptop’s main screen.
	Same
	5 seconds
	Your Recycle Bin icon is not pinned to the main screen of your Desktop/Laptop.

	Step 7
	Select Empty Recycle Bin option.
	Same
	5 seconds
	Your Recycle Bin icon is not pinned to the main screen of your Desktop/Laptop.



	Task Name: Making Calls for and Adding Contacts: Searching for and Adding Contacts

	Step Number
	Resources Used
	Time
	Problems 

	Step 1
	On the Skype main window, click the Contacts tab.
	Desktop/Laptop, Mouse, Keyboard, Phone Directory/Contacts List, Skype
	5 seconds
	None.

	Step 2
	Click on Add a Contact > Search Skype Directory.
	Same
	5 seconds
	None.

	Step 3
	Type in the contact’s full name in the search bar > Click Search Skype.
	Same
	10 seconds
	None.

	Step 4
	1.) Scroll through the list of results and find the right contact> Click on their Profile Picture to highlight the text > Click Add to Contacts.

2.) Backspace the contact name in the search bar and type in a different contact name. Repeat instructions.
	Same
	5 minutes and up
	Hard to find contact in mind because many people share the same First and Last Names and live in the same country.

	Step 5
	OR: If you know the contact’s name and phone number, click on the Contacts tab on the main Skype window.
	Same
	1 minute
	None.

	Step 6
	Click on Add a Contact > Save a number.
	Same
	5 seconds and up
	None.

	Step 7
	1.) Type in the contact’s Name, Number and select the type (source) of phone number presented > Click Add Number button.

2.) Repeat instructions for every contact.
	Same
	10 seconds
	None.

	Step 8
	1.) To create a Contacts List, click on the Contacts tab > Contact Lists > Create New List.

2.) Type in the name of the new Contact List.

3.) Repeat to create other Contact Lists.
	Same
	15 seconds and up
	None.

	Step 9
	To add a contact to an existing Contacts List, right click over the telephone icon or their Profile Picture and select Add to List > select the List you would like to add the contact to.
	Same
	5 seconds
	None.






	Task Name: Making Calls to Online Contacts: Plugging in Web Camera (if not built-in) to computer)

	Step Number
	Resources
	Time tComplete Task
	Problems Encountered

	Step 1
	Follow the manufacturer's instructions to connect the webcam to your computer.
	Desktop/Laptop, Mouse, Keyboard, Webcam
	5-10 minutes
	Instructions for installing webcam are not translated in the language of your choice or comfort.

	Step 2
	Software for your webcam should automatically install (or you may need to install it using the manufacturer-provided disc).

	Same.
	5-10 minutes
	Manufacturing problem for webcam or webcam software.

	Step 3
	After the software has finished installing, sign in to Skype.

	Same resources and Skype
	1 minute
	Software for webcam is not properly installed.

	Step 4
	Check to see if your webcam is working:

 1.) On Windows desktop: Select Tools > Options > Video Settings. 

2.) If you see video, your camera is working and ready to use. 



	Same resources and Skype
	1 minute
	The webcam may not be properly installed.
-The webcam may be too old to support Skype on Windows 10.



	Task Name: Making Calls to Online Contacts: Plugging-In Microphone

	Step Number
	Resources
	Time Taken to Complete
	Problems Encountered

	Step 1
	Microphones and headsets have one of two types of plug: mini jack plugs or a USB plug.

Mini jacks come in different styles and may be colour-coded. Some have symbols with a microphone symbol on one jack and a headphone symbol on the other.

	Microphone with a mini jack plug, Desktop/Laptop, Keyboard, Mouse
	N/A
	None.

	Step 2
	To connect your microphone, insert the pink plug (or the plug with the microphone symbol) into the port on your computer with the matching colour or symbol.
	Same
	5 seconds
	Microphone jack is too big or too small for the port on Desktop/Laptop with matching symbol or colour.

OR: You have a microphone with a USB plug.

	Step 3
	OR: Your microphone might have a USB plug.

To connect your USB headset, microphone or speakers, put the USB plug into any USB port on your computer.
	Same
	5 seconds
	You have a microphone with a mini-jack plug.



	Task Name: Making Calls to Online Contacts: Testing the Microphone

	Step Number
	Resources
	Time Taken to Complete
	Problems Encountered

	Step 1
	1.) Make a free test call in Skype. The test call prompts you to record a message, and then plays it back for you – it’s the easiest way to see if there’s an issue with your audio settings.

2.) To check that your sound and microphone are working properly in Skype, you can make a test call to the assistant Echo. She will prompt you to record a message, and then play it back for you – so you’ll know right away if your sound is working.
	Desktop/Laptop, Keyboard, Mouse, Skype
	5 minutes
	Microphone still does not work. Then check your internet connection and make sure the signal is strong to avoid dropped calls or weak microphone sound.

	Step 2
	On the Skype main window, search for the Echo/Sound Test Service contact.
	Same
	5 seconds
	None.

	Step 3
	Call Echo and follow her instructions.
	Same
	5 minutes
	None.

	Step 4
	If you heard Echo’s voice and heard your recorded message, then your sound and microphone are working just fine and you are good to go.
	Same
	5 minutes
	You cannot hear Echo’s voice (a microphone issue).

OR: You cannot hear the playback message (a microphone issue).




	Task Name: Making Calls to Online Contacts: Video-Calling Contacts

	Step Number
	Resources
	Time  Complete
	Problems 

	Step 1
	Click on the contact you would like to video-call.
	Desktop/Laptop, Keyboard, Mouse, Microphone, Webcam
	5 seconds
	The contact may only be available for mobile or home phone calls-video-calling not available to these devices from Skype.

OR: The video keeps freezing (internet connection issue).

	Step 2
	Click on the video camera icon to instigate a video-call. 
	Same
	Varies
	Same.

	Step 3
	Click on the red telephone icon to end the conversation.
	Same
	1 seconds
	None.



	Task Name: Making Calls to Online Contacts: Voice-Calling Only 

	Step Number
	Resources
	Time
	Problems 

	Step 1
	Click on the contact you would like to Phone or Mobile Call.
	Desktop/Laptop, Mouse, Keyboard, Microphone
	5 to 10 seconds
	None.

	Step 2
	Click on the Phone icon to instigate a Phone Call. 
	Same
	Varies
	You cannot hear the other person (contact) when you call them (microphone issue).

OR: The other person (contact) cannot hear you (microphone issue).

OR: Frequently dropped calls (internet connection issue).

	Step 3
	Click on the red telephone icon to end the conversation.
	Same
	1 second
	None.






	[bookmark: _Hlk493668376]Task Name: Settings: Setting-up Voicemail

	Step Number
	Resources
	Time Taken to Complete
	Problems

	Step 1
	1.) Start Skype and choose Tools >Options >Calls> Voicemail from the main menu.

2.) The Voicemail window pops up. You can purchase Skype Voicemail separately, or you can get Voicemail for free with a Skype subscription.

	Desktop/Laptop, Mouse, Keyboard, Skype, Skype Credit, Microphone
	5 seconds
	You do not have Skype Credit or a Skype subscription and cannot create a voicemail.

	Step 2
	Put a checkmark in front of Send unanswered calls to voicemail.
In this window, you also see the three buttons you can use to record and play back your Voicemail greeting.

	Same
	5 seconds
	Same.

	Step 3
	1.) Just click the Record button (the green button with the triangle) and speak the Voicemail greeting you want callers to hear.
2.) Your greeting or welcome message may be up to 60 seconds in length.

	Same
	1-2 minutes
	Same.

	Step 4
	Click the Stop button (the red button with the dot) when you’re finished recording.
	Same
	1 seconds
	Same.

	Step 5
	1.) Click the Replay button (the red button with the backward arrow) to listen to the message you just recorded.
2.)  If you don’t like what you hear, you can press the Record button again and re-record your greeting.

	Same
	1-5 minutes
	Same.

	Step 6
	When you’re satisfied that you recorded the perfect message, click Save.
	Same
	1-2 minutes
	Same.

	Step 7
	Enter a number in the I Do Not Answer within…Seconds box; This gives you control of how soon to switch incoming calls to Voicemail.

	Same
	5 seconds
	Same.

	Step 8
	Select the I Reject an Incoming Call box:
This allows you to send calls to Voicemail when you do not want to talk.

	Same
	5 seconds
	Same.

	Step 9
	Select the I Am Already in a Call check box:
This sends calls to Voicemail when you are already in another conversation.

	Same
	5 seconds
	Same.



	Task Name: Settings: Listening to Voicemail

	Step Number
	Resources
	Time 
	Problems 

	Step 1
	If someone has recently left you a message, you will see a notification in your recent conversations list.
	Desktop/Laptop, Mouse, Keyboard, Skype, Skype Credit, Microphone
	5 seconds
	You cannot hear the message. 
-Try turning-up the volume on your computer.

	Step 2
	Click the contact’s name in the Recent list, then in the conversation window, click the Play button next to the message.
	Same
	1 minute
	None.

	Step 3
	After you have listened to a voice message, it is stored locally on your computer:

This means that you won’t be able to listen to it again if you sign in to Skype on a different device.
	Same
	N/A
	You cannot access the voicemail message on another device.

	Step 4
	After you’ve listened to a voice message, just click the trash can icon to delete it.
	Same
	5 seconds
	None.



	Task Name: Troubleshooting: Resolving an Echo

	Step Number
	Resources
	Time 
	Problems 

	Step 1
	Make sure you and the person you are calling are using the latest version of Skype for maximum sound quality.

Download latest version of Skype at: 
https://www.skype.com/en/download-skype/skype-for-computer/
	Desktop/Laptop, Mouse, Keyboard, Skype, Microphone, Speakers
	5 minutes
	You are already using the latest version of Skype and the echo persists.

	Step 2
	Check your computer:

1.) If you're using Skype on a Laptop and you're in power-saving mode, try plugging the Laptop into AC power or switching it to maximum performance mode.

2.) Check the Computer tab of the Call Quality Indicator to see if your computer is causing any issues.

	Same
	5 minutes
	The echo persists.

	Step 3
	Close any applications that could be interfering with your call. File sharing applications, streaming audio or video, or even just having a web browser open are all things that can eat up bandwidth. 
	Same
	5 minutes
	The echo persists.

	Step 4
	The problem may be with the device of the person you're calling. Ask them to turn down their playback volume.
	Same
	5 minutes
	The echo persists.

	Step 5
	Make sure your microphone and speakers aren't blocked or muted, and are plugged in if you're using a computer. 
	Same
	1 minute
	The echo persists.


	Task Name: Troubleshooting: Webcam Issues

	Step Number
	Resources
	Time 
	Problems 

	Step 1
	Make sure you and the person you are calling are using the latest version of Skype for maximum audio and visual quality.

Download latest version of Skype at: 
https://www.skype.com/en/download-skype/skype-for-computer/
	Desktop/Laptop, Mouse, Keyboard, Skype, Microphone, Webcam
	5 minutes
	Webcam does not function as it should. 

Check the Webcam’s manufacturer’s site for help.

	Step 2
	Check your internet connection:

1.) If the video freezes, looks block-like or has motion blur, it might be your internet connection (or your friend’s) causing the problem. 

2.) If Skype detects a weak connection, it will reduce the quality to try and stop the call from dropping altogether.

	Same
	5 minutes
	Webcam does not function as it should. 



	Step 3
	If using a computer, plug your Ethernet cable directly into your modem or router. If you're using Wi-Fi, try moving closer to the router. 
	Same
	5 minutes
	Webcam does not function as it should. 



	Step 4
	Check your Web Cam:

1.) Make sure your camera is installed, plugged into your computer, and turned on. If you’re using an external camera and you’re having problems with video, try plugging it into a different USB port. If you’re using a USB hub, try plugging it directly into your computer.

2.) Make sure the Web cam is pointed directly at you and there are no obstructions.
	Same
	5 minutes
	Webcam does not function as it should.



	Step 5
	1.) Check your privacy settings: In Skype, select Tools, then select Options.
 
2.) In the Skype Options window, under Automatically receive video and share screens with, make sure that either anyone or people in my Contact list only is selected. If you select no one, you won't be able to see any video. 

	Same
	5 minutes
	Webcam does not function as it should. 


	Step 6

	When you’re in a video call, make sure that your video is switched on. If the video button has a line through it, like this, it means it’s switched off. Click the video button to switch it on. 
	Same
	2 minutes
	Webcam does not function as it should.




	Task Name: Troubleshooting: Cannot Hear the Other Party or the Other Party Cannot Hear Me

	Step Number
	Resources
	Time 
	Problems 

	Step 1
	Check your audio.
Try playing a song or using another application with sound. If you can hear it, the problem may be with the other person on the call - ask them to follow these steps too.
 
On Windows desktop: 
Select Tools > Options > Audio settings, then in the Speakers drop-down choose the playback device you want to use. 

	Desktop/Laptop, Mouse, Keyboard, Skype, Microphone
	5 minutes
	Still no audio.

Check the manufacturer’s website for help on the microphone that you purchased.

	Step 2
	Run the Audio Trouble Shooter on Microsoft:

1.) To run the trouble-shooter, select the Start button (Windows button on the bottom left corner on your Desktop/Laptop’s main page for Windows 10.

2.)  Type Troubleshoot.

3.) Select Troubleshoot from the list of results. 

4.) Select Playing Audio > Run the trouble-shooter.

	Same
	5 minutes
	Still no audio. 

Check the manufacturer’s website for help on the microphone that you purchased.



1 Usability Goals (Requirements)
The Skype User Guide for Beginners is targeted towards individuals that live abroad and are separated from their other family members and friends by physical distance. The User Guide will teach an individual with moderate computer skills how to download Skype, create a user account, add contacts, video call and voice call their contacts, record a voicemail, listen to recorded missed messages and how to troubleshoot and solve errors regarding Web Cam and Microphone installations. In addition, a 30-second video will be presented as a commercial, advertising the voice calling, video calling and file sharing features of Skype that can run on a Windows 10 Desktop or Laptop. Furthermore, a 3-minute video will present the exact same material as the 30-second video, but highlight additional features like recording voicemail, listening to messages and adding contacts. Basic troubleshooting solutions to microphone and Web Cam issues will also be highlighted. Both videos will be featured on Skypes Online Help Website. With step-by-step instructions and links to Skype’s Online Help Website, potential users have many resources to help them learn how to use Skype. 
Existing Documentation and Resource Requirements
1.1 Planning Documents
The Skype User and Task Analysis Report formulated for the use of the “Connecting Families Abroad” Skype project will be used. The personas in the user analysis and the recorded tasks will be used to create step-by-step instructions to teach users how to download, navigate through and use Skype for video calling, voice calling and file sharing. 

1.2 User Documents 
The User Task Analysis Report formulated for the use of the “Connecting Families Abroad” Skype project will be used. The personas (target audience)-as well as their extended family members or friends that will be exchanging communications on Skype-are used as case study examples that set the tone for how the Skype User Guide for Beginners should be written. All the personas are at least bi-lingual and may require translations of the User Guide in languages other than English; such translations will take place in the form of closed captioning for the 30-second video and the 3-minute video available on Skype’s Online Help Website. Also, larger print and high-contrast colours is suggested for use in the publishing of the User Guide in print format.

1.3 Other Documents
The Skype User Guide for Beginners will be compacted and presented in script for a 30-second video and a 3-minute video available on Skype’s Online Help Website. The wording may be similar, but the approach will be slightly different as videos are shorter and more visual.

4.4	 Writer’s Requirements
The writers should have access to the User and Task Analysis formulated or the “Families Living Abroad” Skype project to gain a better understanding of the target audience that the Skype User Guide for Beginners will be written for. In addition, the User and Task analysis will be used to formulate content highlighted in the accompanying 30-second commercial video about “How to Use Skype” and the more detailed 3-minute video highlighting the basic features of Skype that are part of the free software download. Writers will also need access to test systems for document testing and the ability to take screen captures with software like HiJaak, Paint Shop Pro or Snag IT. Also, writers will need access to Subject Matter Experts (the software developers of Skype) to ensure that the step-by-step instructions of how to complete simple tasks is accurate and user-friendly. In addition, writers need to communicate with the product development and software engineering teams to ensure their content is updated at the same time as the project specification changes and upgrades. 

4.5	 Software Requirements
Writers of the Skype User Guide for Beginners will need to utilize Adobe FrameMaker to organize the content of the Guide. The screen shot tool option of Paint Shop Pro will be utilized to create accompanying pictures for the content in the User Guide. Also, the 30-second video and 3-minute video will be recorded using Captivate, to how users a run-through of how to navigate through Skype’s basic features. Graphics processing and editing will be done on Adobe Photoshop and Adobe Illustrator. The closed captioning translations of the 30-second video and 3-minute video will be created primarily on Microsoft Word for Word Processing. Soon, as another project, RoboHelp will be used as the web authoring tool to make the Skype User Guide for Beginners available on the Skype Website, along with its language translations.
Design Implications

Although Skype has many more features than the basic video calling, voice calling and file sharing applications, the Skype User Guide for Beginners will focus mainly on these tasks that come standard with a free download of the Skype software. Skype Credit services like enabling users to make landline or cell phone calls, as well as the perks of becoming a Skype subscriber, are not included in the Skype User Guide for Beginners. As indicated, this version of the Skype User Guide for Beginners will target individuals that plan on installing Skype onto their Laptop or Desktop that runs on Microsoft Windows 10, have a stable internet connection, have proficient computer skills and are moderate to fluent in written and spoken English.

The Skype User Guide for Beginners will be published in print format, approximately 8.5” by 11” with larger font size and high contrast colours for users with weakened eye sight. There will be a high gloss finish to the pages and the User Guide will be available in both Hard Cover and Soft Cover options. The User Guide will be printed in English, but language translations will be available on Skype’s Online Help Website soon.

Regarding the 30-second commercial about Skype’s basic voice calling, video calling and file sharing features, extensive features of Skype will not be included (e.g. using Skype Credit to call landlines or mobile phones or recording a voicemail message and listening to messages left by others). Also, the 3-minute video will include the same material as featured in the 30-second commercial video, but elaborate on the topics of setting-up voicemail, adding contacts and solving Web Cam and microphone issues while using Skype. 
6	Specifications
6.1	 Platforms Supported
1.) Skype User Guide for Beginners in Book Format.
2.) 30-second Commercial Video available on Skype’s Online Help Website.
3.) 3-minute tutorial video about “Getting Started with Skype” on Skype’s Online Help Website.

6.2	 Skype User Guide for Beginners Book Specifications
	Book Title
	Primary Audience
	Format

	User Guide
	Users
	Print, HTML


[bookmark: _Toc214865858][bookmark: _Toc466743516][bookmark: _Toc494635445]6.3	Document specifications 
The Skype User Guide for Beginners will teach Users how to Download Skype, Install Skype, Boot Skype and how to Create a Skype Account. In addition, the User Guide will cover how to Search for Contacts, make Video Calls, make Voice Calls, how to Add and Test a Microphone and Web Cam, how to Set-up Voicemail and Listen to Voicemail and how to troubleshoot Microphone and Web Cam issues.

	Task Name:
	Resource Name:

	File name
	Skype User Guide for Beginners

	Publication/form number
	Frm123

	Translation recommended
	Yes 

	Internal or External circulation
	Internal

	Softcopy only
	No

	Source format
	Word, XML, HTML

	Final outputs available
	Print and eventually PDF AND HTML

	Distribution 
	Print/Web / Intranet

	Tools used
	Adobe FrameMaker, Adobe Illustrator, Adobe Photoshop, Paint Shop Pro., Microsoft Word

	Page size
	8.5 x 11

	Total number of pages
	185

	Number of new/changed pages
	50/45

	Total number of screen captures
	85

	Number of new/changed screen captures
	20/30

	Total number of line art pieces
	20

	Number of new/changed line art pieces
	10/10

	Hole punches
	3

	Binding type
	Perfect


[bookmark: _Toc180823622][bookmark: _Toc214865859][bookmark: _Toc466743517][bookmark: _Toc494635446]
 6.4		Online Help Specifications
The online, 30-second commercial video for the Skype User Guide for Beginners and the online 3-minute tutorial video for the Skype User Guide for Beginners will both be posted on Skype’s Online Help Website.
Online help specifications include the following: 
	Task Name:
	Resource Name:

	Source format
	XML, HTML 

	Outputs
	PDF, Printer Friendly pages

	Distribution 
	Web / Intranet

	Tools used
	Adobe FrameMaker, Adobe Illustrator, Adobe Photoshop, Paint Shop Pro., Microsoft Word, RoboHelp, Captivate

	Total number of web pages
	150

	Number of new/changed web pages
	50/45

	Total number of screen captures
	50

	Total number of portlets
	120

	Number of new/changed portlets
	100/50

	Total number of messages
	50

	Number of new/changed messages
	10/30

	Total number of translatable words 
	10000

	Number of new or changed translatable words 
	300



[bookmark: _Toc180823623][bookmark: _Toc214865860][bookmark: _Toc466743518][bookmark: _Toc494635447] 6.5		List of Final Deliverables

	Document Title:
	Project Owner:
	Date:

	Skype User Guide for Beginners
	Anthia Pun
	Monday, Oct.31, 2017.

	Online Help 30-second Commercial Video
	Anthia Pun
	Monday, Oct.31, 2017.

	Online Help 3-minute Tutorial Video
	Anthia Pun
	Monday, Oct.31, 2017.


[bookmark: _Toc180823625][bookmark: _Toc214865862][bookmark: _Toc466743520][bookmark: _Toc494635449]6.6		Printing, Packaging, and Distribution
Identify the individuals and vendors responsible for printing, packaging and distribution, e.g.: 
· [Vendor] manages the printing, packaging, and distribution of the document.
The Vendor will be Pearson Education, Inc.
· [Writer] will provide the vendor with mailing labels.
Mabel’s Label’s will be the writer responsible for the mailing labels.
· [Webmaster] will publish the PDF file to the website.
Michael Starter Inc. will be the webmaster.
1. Process and Schedule
2.1 Milestones
Milestones for Skype User Guide for Beginners (Print)
	[bookmark: _Hlk494876000]Milestone:
	Deliverable:
	Date:
	Dependent Upon:

	Alpha 
	1st Text draft
	Oct. 11
	Function complete code.

	Beta 1
	2nd draft text, 1st help draft. 
	Oct. 18
	First round of bugs fixed. Beta 1 features implemented. Program ready for external client test.

	Beta 2
	3rd draft text, 2nd help draft
	Oct. 20
	Second round of features and bugs fixed. Beta 2 features implemented.

	Pre-Final
	Review print proof. Review final help.
	Oct.25
	All features and bugs fixed. Program finalized.

	General Release
	All documentation complete and ready to ship.
	Oct.31
	Completion of packaging. Program complete. Approved for release.





Milestones for Skype User Guide 30-second Commercial Video and 3-minute Tutorial Video:

	Milestone:
	Deliverable:
	Date:
	Dependent Upon:

	Alpha 
	Function complete code.
	Oct. 11
	1st Text Draft

	Beta 1
	First round of bugs fixed. Beta 1 features implemented. Program ready for external client test.
	Oct. 18
	2nd draft text, 1st help draft

	Beta 2
	Second round of features and bugs fixed. Beta 2 features implemented.
	Oct. 20
	3rd draft text, 2nd help draft

	Pre-Final
	All features and bugs fixed. Program finalized.
	Oct.25
	Review print proof.
Review final help.

	General Release
	Completion of packaging. Program complete. Approved for release.
	Oct.31
	All documentation complete and ready to ship.



7.2 	Approvals
	Deliverable:
	Approval(s):
	Reviewer(s):

	1.) Skype User Guide for Beginners

	QA Mgr., Prod Mgr., Dev Mgr., Project Lead, Cust Support Mgr.
	Mgr. Tech Comm, Prod Mgr., Dev Mgr., Project Lead, Cust Support Mgr.

	2.) Draft TOC, topic areas, help files knowledge tree
	QA Mgr., Prod Mgr., Dev Mgr., Cust Suppt Rep
	Senior Tech Writer, Development Mgr, Product team members as req.

	3.) 1st text draft, publication layout
	QA Mgr., Prod Mgr., Dev Mgr., Cust Suppt Rep
	Technical Editor, Prod Mgr., Cust Suppt Rep, Product Team members as req.

	4.) Draft help
	QA Mgr., Prod Mgr., Dev Mgr., Cust Suppt Rep
	QA Mgr., JUPITER Prod Mgr., JUPITER Dev Mgr., JUPITER Cust Suppt Rep, JUPITER team as req.

	5.) Final text, final help
	QA Mgr., Prod Mgr., Dev Mgr., Cust Suppt Rep, VP R&D
	QA Mgr., Prod Mgr., Dev Mgr., Cust Suppt Rep, Product team as req.

	6.) Changes after Final
	Change Control Team
	Change Control Team

	1.) 30-second Commercial Video “Getting Started with Skype”
2.) 3-minute Tutorial Video “Getting Started with Skype”
	QA Mgr., Prod Mgr., Dev Mgr., Project Lead, Cust Support Mgr.


QA Mgr., Prod Mgr., Dev Mgr., Project Lead, Cust Support Mgr.
	Mgr Tech Comm, Prod Mgr., Dev Mgr., Project Lead, Cust Support Mgr.


QA Mgr., Prod Mgr., Dev Mgr., Project Lead, Cust Support Mgr.

	3.) Draft TOC, topic areas, help files knowledge tree
	QA Mgr., Prod Mgr., Dev Mgr., Cust Suppt Rep
	Senior Tech Writer, Development Mgr, Product team members as req.

	4.) 1st text draft, publication layout
	QA Mgr., Prod Mgr., Dev Mgr., Cust Suppt Rep
	Technical Editor, Prod Mgr., Cust Suppt Rep, Product team members as req.

	5.) Draft help
	QA Mgr., Prod Mgr., Dev Mgr., Cust Suppt Rep
	QA Mgr., Jupiter Prod Mgr., Jupiter Dev Mgr., Jupiter Cust Suppt Rep, Jupiter team as req.



7.3		Review Process Schedule
1.) Design review:  A review of the deliverable design by the client, Skype.
Date: Oct.11, 2017.

2.) Draft reviews:  Skype User Guide for Beginners, Script for 30-second Commercial Video, Script for 3-minute Tutorial Video.
First Review Date: Oct.23, 2017.
Second Review Date: Oct.25, 2017.

3.) Final review:  This is a review of what should be the final version of each deliverable.
Date: Oct.26, 2017.

4.) Sign off:  This is the sign off by the client that the deliverable is acceptable for publication.
Date: Oct.30, 2017.

5.) Deliverable to production:  The date the deliverable is sent from the documentation team to whoever will produce the final product. 
Date: Oct.31, 2017.
[bookmark: d4e70]
6.) Deliverable published for users:  The date the deliverable is first in the hands of a user (not counting possible user reviews).
Date: Nov.8, 2017.

7.) Dependencies: This includes milestones for deliveries to your team or other dependencies. 
Dates: Oct.11, 2017., Oct. 18, 2017., Oct.20, 2017., Oct. 25, 2017., Oct.31, 2017. 
Resources
8.1	Technical Writing Staff
Responsibilities for the Skype User Guide for Beginners (Print)
	Milestone:
	Deliverable:
	Date:
	Dependent Upon:

	Alpha 
	1st Text draft
	Oct. 11
	Michael Dean

	Beta 1
	2nd draft text, 1st help draft. 
	Oct. 18
	Marcus Rowan

	Beta 2
	3rd draft text, 2nd help draft
	Oct. 20
	Alethea Saint

	Pre-Final
	Review print proof. Review final help.
	Oct.25
	Martinique Dominique

	General Release
	All documentation complete and ready to ship.
	Oct.31
	Vodka Martini



8.2	Interfacing Groups
A description about the resource and contact personnel who need to know about the original Skype User Guide for Beginners document (print) and the script for the 30-second commercial video and 3-minute tutorial video.
	Group:
	Contact Name:
	Responsibilities:

	Product Development Software Engineering
	Leslie Ann
Ronald McDonald
	Review all documentation for technical accuracy and completeness.

	Professional Services
	Old Saint Nick
	Review all documentation for accuracy and completeness with respect to industry.

	Quality Assurance
	Mrs. Claus
	Review all documentation for quality; test documentation.

	Product Marketing
	Bilbo Baggins
	Review all documentation for consistency with marketing strategies.

	Customer Support
	Shania Twain
	Review all documentation for usability; test documentation.

	Graphics Team
	Magic Michael
	Review all documentation and apply appropriate graphics where needed.

	
	
	




9	Risks 
	Assumption:
	Risk:
	Likelihood:
	Contingency:

	Alpha: Function complete code is completed by Oct.11, 2017.
	· 1st text draft not completed on Oct.11
· Function complete code is not ready by Oct.11.
	Low: If the function complete code is not completed on time, the first text draft cannot be completed.
	Have software engineering team work overtime to meet the deadline.

		Beta 1 completed by Oct.18, 2017.



	· 2nd draft text, 1st help draft not completed by Oct.18
· First round of bugs is not fixed; the features are not implemented by 0ct.18
	Moderate: Program is not ready for external client test.
	Have Tech Writers work overtime to meet the deadline.

	Beta 2 completed by Oct.20, 2017.
	· 3rd draft text, 2nd help draft not completed by Oct.20
· Second round of features and bugs are not fix; features not implemented by 0ct.20
	High: Beta 2 features are not implemented.
	Have Tech Writers and Software Engineering teams work overtime to meet the deadline.

	Pre-final completed by Oct.25, 2017.
	· Print Proof and Final Help have not been reviewed by Oct.25
· All bugs and features are not fixed by Oct.25

	High: Program is not finalized.
	Have Tech Writers and Software Engineering teams work overtime to meet the deadline.

	General Release on Oct.31, 2017.
	· All documentation is not ready for shipment by Oct.31
	High: Public will not get to access the Skype User Guide for Beginners or the 2 videos by Nov. 8
	Have Tech Writers and Software Engineering teams work overtime to meet the deadline.
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